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Introduction

1.1

About Accurate Printer Monitor

1

Printer monitoring is indeed a lot of companies all over the world should invest in. But why is this so?
Why is there an imminent need to monitor printing activity? Let us say that you operate a mediumsized enterprise and you have dozens of computers connected to three or four computer networks.
With this many computers, your office would inevitably need a lot of working printers at hand, so
many that keeping tabs as to printing activity would become fairly difficult it achieve. The task to
monitor printers is not really hard if you have software to back you up. It is why you need to have
print monitor software in your office.
Another great feature that comes with print monitoring software is that it points out the employees
using the printers most often, as well as the number of pages they have been printing off the printers.
Now, this goes without saying that there are employees who are just a little bit abusive when it
comes to using office equipment and when it comes to printing, there really is no way of knowing
who is using what printer for personal use. That is if you do not have the software. With the software,
this is easily carried out because it keeps track of all documents printed as well as the employee
who printed them respectively. These reports are then stored inside a built-in database that you can
easily access to monitor abusive users.
Our printer monitor also comes with built-in notification capabilities. That is, in the case that anything
remarkable is found in any of the printer's work that the program is currently monitoring, it could
simply send off an email to the human administrator. It saves administrators a lot of tedious labor in
looking through many printers and frees their time for more important and complex administration
tasks.
Key features of Accurate Printer Monitor:
· Capability to monitor multiple printers at the same time. Each printer may have fully different
monitoring and exporting settings;
· Allows monitor local, remote, or network printers;
· Real-time optimized monitoring;
· The program automatically detects when the printer or print server goes offline and restores
monitoring when the printer is online;
· Supports color and monochrome printers;
· Can send notification via email and several other methods;
· Can save printer events to databases MSSQL, MySQL, MS Access, Oracle, Interbase, etc.;
· Many modules allow you to filter events and process printer events;
· You can calculate printing cost for each printer, domain or user, paper size or print quality;
· Many reports, which you may save to Adobe PDF or MS Word files;
· The printer monitor can send scheduled reports to administrators;
· Built-in HTTP server allows administrators or users to display company or individual reports from
remote computers;
· Simple, menu-driven step by step set-up - Programming is not required to configure the software to
collect data;
· It supports various operating systems. The logger runs on all versions starting from Windows 2000,
including 32 and 64-bit systems.
Unlike most other printer monitoring applications, Accurate Printer Monitor can run as a service so
that it starts as soon as the operating system starts and doesn't require a user to log in and run it. It
will continue to run even as the user login and logoff the workstation.
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It is extremely easy to use! The configuration process is fully menu-driven and has complete,
context-sensitive, online help. You can easily customize all input to your exact specifications. Once
you see how easy it is to use Accurate Printer Monitor, you will never again take data readings by
hand!

Typical usage
This software is mainly used in a centralized supervising system of all your printers. With this software, you can monitor printing activity more efficiently, thus preventing your employees' personal use
of your printers. It just cannot be helped; there are times when your employees would use your printers to print some documents that are not related to work at all.

Applications examples
· Printer accounting;
· printer monitoring;
· Printer logging.

Company home page: http://www.aggsoft.com/
Software home page: http://www.aggsoft.com/printer-monitor.htm

1.2

Glossary
ASCII - An acronym for American Standard Code for Information Interchange. ASCII files are plain,
unformatted text files that are understood by virtually any computer. Windows Notepad and virtually
any word processor can read and create ASCII files. ASCII files usually have the ".TXT" extension
(e.g., README.TXT).
Binary File - A file that contains data or program instructions written in ASCII and extended ASCII
characters.
Bit - A binary digit in the binary numbering system. Its value can be 0 or 1. In an 8-bit character
scheme, it takes 8 bits to make a byte (character) of data.
Bytes - A collection of eight bits that represent a character, letter or punctuation mark.
Cable - Transmission medium of copper wire or optical fiber wrapped in a protective cover.
Client/Server - A networking system in which one or more file servers (Server) provide services;
such as network management, application, and centralized data storage for workstations (Clients).

PC - abbreviation for a Personal Computer.
Ports - is a connection point for a cable.
Protocol - is a formal description of a set of rules and conventions that govern how devices on a
network exchange information.
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2.1

License

3

Copyright © 1999-2021 AGG Software.
All Rights Reserved

SOFTWARE LICENSE
Trial Limited Version
The trial limited version of this software may be used for evaluation purposes at the user's own risk
for a trial period. At the end of the trial period, the user must either purchase a license to continue
using the software or remove it from his/her system.
The trial limited version may be freely distributed, provided the distribution package is not modified.
No person or company may charge a fee for the distribution of Accurate Printer Monitor without
written permission from the copyright holder.

Licensed Version
On payment of the appropriate license fee, the user is granted a non-exclusive license to use
Accurate Printer Monitor on one computer (i.e. a single CPU), for any legal purpose, at a time. The
registered software may not be rented or leased but may be permanently transferred, if the person
receiving it agrees to terms of this license. If the software is an update, the transfer must include the
update and all previous versions.
Registered customers are entitled to free updates during one year from the date of purchase. It
means that for one year you can download and install the latest registered versions of Accurate
Printer Monitor from our site. If you don't want to purchase an update, you can use the program
forever; it will never expire, but you won't be able to use the latest version. If you purchased the
software more than one year ago, you are no longer entitled to free upgrade and technical support;
however, you can purchase an update to the latest version at a special, greatly discounted price, and
this update will allow you to have free updates and technical support for another year. The type of the
update license must match the type of your existing license.
Whilst every care has been taken in the construction and testing of this software, it is supplied
subject to the condition that the user undertakes to evaluate the suitability of the control for his/her
purposes. AGG Software makes no representation of the software's suitability for any purpose, and
the user agrees that AGG Software has no responsibility for any loss or damage occasioned by the
use of this software.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE SOFTWARE AND
DOCUMENTATION ARE PROVIDED "AS IS" AND AGG SOFTWARE DISCLAIMS ALL OTHER
WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, CONFORMANCE WITH DESCRIPTION, TITLE AND NON-INFRINGEMENT OF THIRDPARTY RIGHTS.
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TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL AGG
SOFTWARE BE LIABLE FOR ANY INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
EXEMPLARY DAMAGES OR LOST PROFITS WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF
THE USE OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF AGG SOFTWARE HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, AGG SOFTWARE'S
CUMULATIVE AND ENTIRE LIABILITY TO YOU OR ANY OTHER PARTY FOR ANY LOSS OR
DAMAGES RESULTING FROM ANY CLAIMS, DEMANDS OR ACTIONS ARISING OUT OF OR
RELATING TO THIS AGREEMENT SHALL NOT EXCEED THE PURCHASE PRICE PAID FOR
THIS LICENSE.
Should any term of these terms and conditions be declared void or unenforceable by any court of
competent jurisdiction, such declaration shall have no effect on the remaining terms hereof.
If you do not agree to these conditions you should not install this software.

2.2

Limitations
The unlicensed program works in the trial mode. The program allows to test all features, but it limits
the time and/or amount of processed data. The license key removes all limitations from the trial
version. You may purchase a license key here 4 .
The trial version of our software has the following limitations:
· The trial period is limited to 21 days. After that time, the program stops working.
· The continuous program work time is limited to two hours. After that period the program shows a

message and stops working;
· All data export modules can handle the first 100 records only;

2.3

How to acquire a license
The unlicensed program works in the trial mode. The license key removes all limitations from the trial
version and allows you to use our technical support for one year.
If you want to buy a program through the Internet, visit the order page of our site. On this page, you
can get the newest information about the registration process, and also find an order link. Please,
follow the “Buy now” link, enter your personal information, and choose the most convenient payment
method for you. Further, you will get a notification and follow the notes in it.
You may find more information about our policies, payment terms, payment methods, and frequently
asked questions on our web site.
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Support
Technical questions

support@aggsoft.com

Common questions

info@aggsoft.com

Sales questions

sales@aggsoft.com

3

Installation

3.1

System requirements
Windows 2000 Professional - Windows 10 (2019), including x64 and x86 OS, Workstation, and
Server OS.

3.2

Installation process
If any beta-version was installed on your computer, remove it.
Quit of the working Accurate Printer Monitor on installation time.
Run an installation file.
By default, the installation wizard installs Accurate Printer Monitor to "C:\Programs Files\Accurate
Printer Monitor" or "C:\Programs Files (x86)\Accurate Printer Monitor" the directory of your system
disk, but you can change this path.
In the standard distributive of Accurate Printer Monitor are no additional modules files, which you can
download from our site.

4

Program use

4.1

Getting started
After you have successfully installed Accurate Printer Monitor, use the following simple steps to
configure and run it.
Open the Accurate Printer Monitor program from the Start Menu.
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At program run, you get into the main program window (fig. 1.1.1), main elements of which are the
main menu, the data window, the program messages list, and the status bar.
- The data window shows incoming data before or after processing. You can configure the data view
mode in the settings
- The drop-down box at the bottom shows all logged program info, warning, and error messages.
- The status bar shows the current state of the selected data source, errors on the data interface,
and how many bytes were sent or received.
- The toolbar above the data window provides fast access to the configuration.
- The main menu above the toolbar allows you to edit the program settings 7 ("Options -> Program
settings..."), manage configurations, open the current logfile from the "File" menu (fig. 1.1.2).

Fig. 1.1.1 Main program w indow

Fig. 1.1.2. "File" m enu item

By default (after installation), the program has not any data sources configured. If the list of data
sources on the toolbar is empty, then the program will ask you to add a new configuration.
Otherwise, the program will fill in the list of data sources and try to start logging of data sources
configured. Yes, of course, all your settings are being saved while exiting from the program and
loaded during the program start.

Set-Up is as Easy as 1-2-3
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Step 1. Configure one or more data sources.
Click the "Add configuration" button on the toolbar with a big green plus and choose printers
"Printers" tab of the "Configuration options" dialog lets you configure your settings.

10

. The

Step 2. Configure log file.
Select the "Log file" header in the configuration dialog window and enable logging for a necessary
data direction.

Step 3. Define how you want printers data to be parsed and translated

41

.

The "Plug-in" button on the toolbar in the main window or "Modules" tab in the dialog window lets you
specify how to parse, filter and format your data to the fit the exact format required by your
application. It also lets you pre-define automatic output strings to be sent to an external device.
Now, the program process and exports data from one or multiple data sources.

4.2

Introduction
Accurate Printer Monitor can save data to a log file(s) without any changes (i.e., create raw binary
log files) or write to log files depending on the parser module selected. In the first case, you can view
the log file with any hex editor and use this data for further analysis and remaking. In the second
case, you can view data with any text editor. You can find more information about log files in the
"Log rotation 36 " chapter.
You can watch the data in the data window (fig. 1.1.1 5 ). The data view is fully customizable. You
can watch data in decimal, hexadecimal, or your format. How to customize data view you can read in
the "Data view 32 " chapter and how to customize program view you can read in the "Window view 77
" chapter.
The data can be exported or transferred to one or more targets. The simplest way is to configure the
log file rotation. However, it is small a part of all features of Accurate Printer Monitor. Accurate
Printer Monitor has many additional modules 41 (so-called plug-ins) that are appreciably extending
possibilities of the logging software. You can download and install any module supported. Most
modules are free of charge for our customers. How to install and configure modules you can read in
the "Modules 41 " chapter.
The program and their plug-ins generate many messages and write them to the list in the main
window (fig. 1.1.1 5 ) and a protocol file that you can use for administration of the software. You can
also configure types of system messages. More information about it you can read in the "Protocol
and errors handling 81 " chapter.
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4.3

Data flow diagram
This diagram may help you to understand the flow of data within our software and a place of each
module. The following chapters describe all plugin types.

Fig. 1.2.1 Data flow diagram

History:
- The flow of binary data (RAW, unformatted data).
- The parsed data (formatted data). The data flow is separated into data packets and variables.
Each data packet can be interpreted as a row, and each variable can be interpreted as a column.
Wires with other colors mark other relations with the unstructured data flow.
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4.4

Work complete
The program saves all settings to the Windows registry when it stops working. All opened data
sources will be automatically closed (unlocked, unallocated, or fried).

4.5

Useful advices
1. Look through hint helps on all window elements - it may help you to get a picture of this element's
function.
2. You can change all program settings without restarting the program. To transfer settings to
another computer, you can do the following:
1. Create a configuration backup from the "File" menu and restore it using the same menu.
2. Alternatively, export the registry node with all program settings. Start regedit.exe and export the
following registry node:
on Windows x64
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\AGG Software\Accurate Printer Monitor
on Windows x32
HKEY_LOCAL_MACHINE\SOFTWARE\AGG Software\Accurate Printer Monitor
3. On another computer import settings to the Windows registry.
Many main window elements have "hot" keys for quick access to its functions.
· Ctrl+S - analogs to click on "Start/Pause" button on the toolbar.
· Ctrl+C - analogs to click on "Clear" button on the toolbar.
· Ctrl+P - opens the window with the configuration settings.
· Ctrl+L - opens the window with the log file settings.
· Ctrl+W - allows you to configure the data view mode.
· Ctrl+R - shows the window with the program settings.
· Ctrl+E - shows the Windows 2000+ service settings.
· Ctrl+M - here you can configure data query plugins, data parser, and other plugins.
4. You can look at the summary statistic that contains summary about sent and received data,
created files, etc. (View - Statistics)
5. You can save program settings to an INI file. It may help to install and use several copies of the
program. You can make your choice from the "Options" menu.
6. The program window can display only the last 10 messages. The full program log file (if activated)
you can open using the "File - View program protocol file" menu item.
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4.6

Configuration

4.6.1

Printer monitor settings

4.6.1.1

Printer monitoring configuration

Creating a list of printers for monitoring
You can create a new configuration with a click on the button with the "+" sign on the toolbar in the
main window of the program (fig. 2.7.1) or the "Options" menu. After you click this button, you will
see a new dialog box (fig. 2.7.2). This dialog box has several tabs with options. The "Printers" tab is
described in this section. The installation software could create the default configuration during the
installation of the program. In this case, you can modify the existing configuration by opening it with
the corresponding menu.
To monitor several printers at a time, you need to add these printers to the list. If you need to specify
different modes for monitoring the printers, you should create several configurations. To do it, repeat
the above operation for each configuration. Later, you will be able to access every configuration with
the drop-down menu's help next to the "+" button (fig. 2.7.1).

Fig. 2.7.1 Access to the printer configuration

The "Monitor printers" page allows you to define the list of printers to monitor. You should specify
the name of your group of printers in the "Printer group name" field on this page. This name will be
displayed in the main window of the program.
To add a printer to the list, type the name of the printer in the field and click the "+" button. You can
select a printer from the list that contains all local printers.
To add a remote printer, you should specify the name of the remote computer before the name of the
printer: \\COMPUTER_NAME\PRINTER_NAME, where
COMPUTER_NAME is the name of the remote computer on the local area network. If the printer is
not available by its name, you can specify the computer's IP address instead of
COMPUTER_NAME.
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PRINTER_NAME is the full printer name. In the case of a network printer, you can specify the
network name specified for this printer instead of its full name.
Note 1: to monitor network printers, you need the program to be run as an administrator account. If
the remote computer is not located in the domain, an account with administrator permissions,
username and password must be added on the remote computer. The program will be run as this
account.
Note 2: to monitor network printers, you need to install the client program 12 on the remote
computer and configure it tot write data to the centralized database (for example, MSSQL or
MySQL).
Note 3: to monitor network printers, you need to have shared printer access enabled. To allow
shared printer access for the administrator only, you should add the "$" character to the end of the
network printer name. In this case, it will be possible to access the printer only by specifying its
name explicitly. This printer will not be seen in the network neighborhood.

Fig. 2.7.2 Printer list

The program has several options that ensure printers are constantly monitored:
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Try to reconnect after error - this option allows you to connect the printer to the monitoring
system in the specified number of seconds after a connection error occurs. A connection error often
occurs when the printer is disconnected from the computer or switched off.

Additional tools
You can use the "Tools" button next to the "+" button and the drop-down menu that appears after a
click on this button (fig. 2.7.3) to perform the following operations with the list:

Fig. 2.7.3. Additional tools

Load printer list from file - this menu item allows you to load the printer's list from a text file. Every
line in the text file must contain the name of one printer.
Append printer list from file - this item allows you to add printers from a text file to the existing
list.
Save printer list to file - this item allows you to save all printers from the list to a text file.
Import data from text log files - this item allows you to import log files created by the program
earlier. The data is read from the log file and imported into the database according to the program
settings.
4.6.1.2

Remote client usage
The remote client is a separate program that is installed on client computers and monitors all local
printers on those computers.
Advantages of using the remote client:
1. The remote client automatically determines the list of printers on the local computer. It detects
when a new printer is added and automatically starts to monitor it.
2. The central data collection server is loaded less because the client takes a large part of
monitoring functions upon itself.
3. You don't need to create a list of all printers on the network.
4. You don't need to share access to the printer.
5. The network load is decreased because the client groups and compresses data before sending it
to the server.
6. You do not need to create additional configurations to monitor printers loaded with work.
Disadvantages:
1. It is necessary to install additional software on client computers
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It is necessary to enable the "Enable TCP/IP server" option to receive remote clients' data. The
received data will also be displayed in the program's main window and processed according to the
program settings.
If the "Send monitor settings to remote clients" option is enabled (fig. 2.7.5), all options from the
"Monitor options" page will be automatically sent to remote clients as soon as they are modified on
the server software. If this option is disabled, every client can use its own monitor options.

Fig. 2.7.5. Netw ork server

Remote client installation
The client installation software is distributed as a separate installation package in the MSI format.
This installation file format makes its installation on client computers considerably easier. In
particular, you can do it remotely with the help of Active Directory services.
It is possible to install the client from the command line specifying the default parameters:
Example:
msiexec /i "C:\PrinterMonitorClient.msi" AGG_INSTALLDESKTOPSHORTCUT=""
AGG_DONTINSTALLPROGRAMGROUP="1" /qn
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Command-line parameters:
/qb - quiet installation with the minimum interface
/qn - quiet installation without any requests
AGG_INSTALLDESKTOPSHORTCUT="1" - create a desktop shortcut
AGG_INSTALLDESKTOPSHORTCUT="" - do not create a desktop shortcut
AGG_DONTINSTALLPROGRAMGROUP="1" - do not create a program group in the "Start" menu
AGG_DONTINSTALLPROGRAMGROUP="" - create a program group in the "Start" menu
AGG_PROGRAMGROUP="Accurate Printer Monitor Client" - create a group in the "Start" menu with
the specified name
WIXUI_INSTALLDIR="C:\Custom Program Folder\" - install the program in the specified folder
AGG_SERVER="192.168.0.1" - specify the address of the data collection server the monitoring data
will be sent to
Note: During the remote client's installation, the installation program will automatically add
exceptions for port 4488 for the remote client in the standard Windows firewall. If some other firewall
is used on cli-ent computers, you should allow TCP connections via TCP port 4488.

Remote client configuration
To configure the remote client, you should prepare and apply the program settings on the client
computers. To do it:
1. Install the remote client on one of the computers.
2. Configure the remote client on this computer.
3. Save the client configuration to a file with the ".reg" extension using the "Save and Load - Save
Settings" button in the remote client configuration window.
4. Copy this file to all client computers using the Active Directory services or other remote
administration tools.
If you enable the "Send monitor options to remote clients" option (fig. 2.7.5) on the server and install
the client with the AGG_SERVER command line parameter, there is no need to configure the remote
client. You can complete the above steps in case of the detailed configuration of parameters or
change the data collection server's address.

How the remote client works
The program is installed as a Windows service and is automatically run at Windows startup. While
running, the client monitors adding and removing printers. As soon as a new printer is added, the
program automatically starts to monitor events on this printer. When an event occurs on the printer,
the client sends it to the server. When the client receives a configuration update command from the
server, it sets the received settings and saves them to the registry. If the connection to the server is
unsuccessful, the client saves the events to the internal storage. The events saved to the storage will
be sent when the next event occurs, but not earlier than 10 seconds. The storage can store 1000
events. When the storage is full, the oldest events are permanently deleted from the storage.
The process of how the program works is logged in the file c:\ProgramData\Accurate Printer
Monitor\printermoncli-service.log
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Remote client installation via Active Directory
You can use the Microsoft Active Directory service to install the remote Accurate Printer Monitor
client on a group за computers automatically and remotely. To run the installation procedure, you
need to have administrator permissions for the domain on the computers you want to install the
remote client. Besides, you need to have a network shared folder it is possible to read data from.
1. Save the PrinterMonitorClient.msi package to the network shared folder. For example, \
\SERVER\Install\PrinterMonitorClient.msi.
2. Run the "Active Directory Users and Computers" snap-in. You can do it using the "Start Programs - Administrative Tools".
3. Create a new Organizational Unit (OU) or select an existing one it is necessary to install the
remote computer for. To create a new organizational unit, select the "New - Organizational Unit" item
on the "Actions" menu of the snap-in.
4. Move the computer you want to install the remote client on to the selected organizational unit by
selecting them and selecting the "Move" item on the "Actions" menu.
5. Open the properties of the selected organizational unit. To do it, select the "Properties" item on
the context menu of this unit opened with a right-click.
6. Switch to the "Group Policy" tab of the organizational unit settings.
7. Create a new Group Policy Object (GPO) by clicking the "New" button. Give an appropriate name
to the new object. For example, APMGPO.
8. Switch to editing the group policy object created in the previous step. To do it, select this object
and click the "Edit" button.
9. Switch to the "Computer Configuration - Software Settings - Software Installation" section in the
new window.
10. Add the PrinterMonitorClient.msi installation package to the installation software list. To do it,
select the "Actions - New - Package:" menu item and type the network path to the
PrinterMonitorClient.msi package in the "File name" field of the "Open File" dialog box. For example,
\\SERVER\Install\PrinterMonitorClient.msi. Then you should select the software deployment method.
Select "Assigned".
Note: If you need to install the package with parameters, you should create a BAT file and save it
together with PrinterMonitorClient.msi in the shared folder. You should specify the necessary
command line parameters 13 in the BAT file and add the BAT file to the installation software list
instead of the MSI package.
11. Switch to the "Administrative Templates" tab of the group policy object. Select the "Add" item on
the template context menu and specify the APMClient.adm file (they are distributed together with
Accurate Printer Monitor and are installed in the program folder). The "Accurate Printer Monitor
Client" tab will appear in administrative templates.
Note: Depending on the platform where the client will be installed (x86 or x64), you should install the
template APMClientx86.adm or APMClientx64.adm. You can install both templates simultaneously
for different groups of clients.
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12. Switch to the "Accurate Printer Monitor Client" tab created in the previous step. Disable filtering
in the list (the "View / Filtering" item on the context menu). The "Notify servers" option will appear in
the list after that.
13. Select the "Notify servers" option. Select the server's IP address where the Accurate Printer
Monitor server is installed in the new dialog box. You can also edit additional options specified in the
template. You should at least configure the server address. The client can get all other settings from
the server automatically if the corresponding option is enabled.
If you do everything correctly, the next time you restart the computers added to the organizational
unit, the Accurate Printer Monitor client will be installed and configured on them.
4.6.1.4

Monitor options
The "Monitor options" page (fig. 2.7.6) allows you to customize the program's mode. By default, the
options are configured so that the program logs all events to the database that comes with the
program.

Fig. 2.7.6. Additional options
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Monitor printer events. The program will monitor all events related to the printer: "new job", "task
deletion", "no paper", etc.
Monitor print job events. The program will monitor all events related to each print job: "sending to
the printer", "printing", "printed", etc.

Error correction
Sometimes, due to the drawbacks in the printer driver or firmware (because the printer is supposed
to give information about printed pages), the program receives notifications with invalid data. For
example, the number of pages in the document turns out to be less than the number of printed
pages. For you to be able to fix these problems, the program has a group of options called "Error
correction":
Add the "Printed" status for finished jobs. Sometimes the program may fail to receive the
notification that the print job has been finished. In this case, the printer's data will not be included in
the report that will be generated in the administrative part of the program. If this option is enabled, the
program will monitor the print queue's status and automatically set the "Printed" parameter for
finished jobs.
Total pages < Printed pages. . Suppose an event contains data where the "Total pages"
information field has a value that is less than the one in the "Printed pages" field. In that case, the
program will automatically set "Total pages" = "Printed pages".
Total pages > Printed pages. It is the same as the previous, but the reverse ratio is checked.
Save content of printer jobs. If this option is enabled and specified a folder for saved files, the
server program and remote clients 12 will try to capture spool files (SPL) and convert them to PDF.
Remote clients will transfer captured files to the central server.
Quota checking. This option instructs remote clients to ask for a user name and password before
each print job. Then the client sends a quota checking request to a server and executes an action
returned from the server. You should configure quotas in the Accurate Printer Monitor Administrator.
Ask user name. If this option is enabled, the remote client asks for a user name. Otherwise, it uses
the name of the current user. If this option is disabled, a user cannot print a file under another
account name.
Block print jobs if quota is undefined. If this option is enabled, the remote client blocks all print
jobs if a remote server is offline or unreachable for 5 seconds, or quota is not defined for a current
computer printer and user.
4.6.1.5

Connection types

4.6.1.5.1 With print servers

All users in your network neighborhood print on shared printers (printers with shared access) on one
print server (\\printserver\printer). For example, the following network printers are installed on John's
computer:
Example 1 18 : Accurate Printer Monitor is installed on the central computer or server, not the print
server. For example, \\central_computer
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Example 2

21 :

Accurate Printer Monitor is installed on the print server. For example, \\printserver1

Example 1
Install the program on \\central_computer as it is described in the "Installation Process" section.
Three print servers on the network are used in this example: printserver1, printserver2, and
printserver3. You should add all printers with shared access on all three print servers to the central
computer \\central_computer where our program is installed.
To do it:
1. Open the Printer Control Panel (Start --> Printers and Faxes or Start --> Control Panel --> Printers
and Faxes)

2. Click the "Add a printer" item
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3. Select "Network printer"

4. Select "Connect to this printer..." and then click "Next". You will see the list of printers on your
network.
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5. Printers from two print servers ("CHAMPION" and "SERVER") are added in the picture below.
Note that the printers in the list have the icon of a network printer.

6. After that, add the newly added printers to the list of monitored printers as it is described in the
"Printer monitoring configuration 10 " section. In this case, all printers' names should be specified
without the name of the print server they are located on because they are registered on the central
computer.
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Example 2
Three print servers on the network are used in this example: printserver1, printserver2, and
printserver3. But Accurate Printer Monitor will be installed on the print server computer \\printserver1.
1. Install the program on \\printserver1 as it is described in the "Installation Process" section.
2. Add the printers with shared access from printserver2 and printserver3 to \\printserver1 where the
program is installed. To do it, repeat steps 1-5 from "Example 1". In this case, the printers located
on printserver2 and printserver3 will have the icon of a network printer, while the printers from \
\printserver1 will have the icon of a local printer.
3. After that, add the newly added printers to the list of monitored printers as it is described in the
"Printer monitoring configuration 10 " section. In this case, the names of all printers should be
specified without the name of the print server they are located on because they are registered on the
\\printserver1 computer.
4.6.1.5.2 Without print servers

You use no print servers in your network neighborhood. Users send print jobs to printers directly by
their IP addresses or to printers that are connected locally to workstations via USB, LPT, etc.,
instead of printing on the print server (for example, \\printserver\shared_printer).
Suppose there are two printers connected to John's workstation: a network one that is accessed by
its IP address (for example, HP LaserJet 8150 Series PCL6) and a local one (Epson FX-1180) that is
connected via a USB cable (fig. 2.7.7). Note that both printers have the icon of a locally connected
printer.

Fig. 2.7.7. Local printers

Suppose Accurate Printer Monitor is installed on the central computer named \\centralcomputer.
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1. Enable the TCP server mode in Accurate Printer Monitor as described in the "Remote client
usage 12 " section to receive data from remote clients.
2. Install the remote client on John's computer as described in the "Remote client usage" section.
Configure the remote client on John's computer to send data to the central computer \
\centralcomputer by specifying its IP address.
3. Once started, the remote client automatically gets the list of all local printers and monitors them.
If new local printers are added while the client is running, the client will automatically add them to the
list of monitored printers. By default, the remote client is installed as a Windows service is runs in
the background mode.
4. If printers on John's computer have shared access and other users without locally connected
printers print on these printers, there is no need to install the remote client on those computers. The
client on John's computer will monitor the users' names who print on the printers and their location.

4.6.1.5.3 Netw ork printers

It is necessary to differentiate between two types of network printers:
1. Users access the printer directly by its IP address. If you have no central print server, you should
install the remote client on all computers if it is possible to print on this printer from. To simplify the
printer management process, we recommend:
1. Register this printer on the central computer where Accurate Printer Monitor is installed or on
the user computer where the remote client is installed.
2. Enable shared access to it.
3. All users must print via shared printers.
2. The printer is locally connected to one of the network computers, and shared access is enabled.
In this case, you should install the remote client on the computer the printer is locally connected to.
It will be enough to monitor all print jobs from all users. The program will log who and from which
workstation prints.

4.6.1.5.4 Mixed connection type

Users in your network neighborhood can print both on printers with shared access enabled on the
print server (for example, \\printserver\printer) and on local printers connected directly to a
workstation via such interfaces as IP, USB, LPT, etc.
This case combines the cases "With print servers 17 " and "Without print servers 21 ". In this case,
Accurate Printer Monitor must be installed on the central computer or print server. Simultaneously,
the remote client must be installed on other print servers and also on computers local printers are
connected to.
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Troubleshooting
Problem: The flag (1) appears in the "Color" field when the black-and-white printer is monitored.
Solution: It is possible to select a color or black-and-white printing in the some printers' properties
even though they are black-and-white. If the black-and-white printing is selected, black-and-white
data is sent to the printer, and the program logs it. If the default value is used, it is necessary to
check the printer properties.

Problem: Everything is OK with one printer. It processes ten printers alright. When I add printers,
the program stops logging after I add some printers. Maybe it is somehow related to the network
load?
Solution: The program fails to monitor events for all printers due to the high frequency of events. It is
necessary to divide printers into groups and create several configurations (the button with the green
plus sign in the program's main window). If you create one configuration for one printer's group, the
program will create a separate thread for monitoring events occurring in each group of printers, which
will speed up the program in case there are a lot of printers. You can clone the existing configuration
using the drop-down menu next to the Plus button. You can also install the remote client 12 on
every workstation.

Problem: The program is installed on the server. It writes everything to the database. Printers that
have shared access on a dedicated print server are monitored. It is necessary to monitor printers
connected locally to an employee's computer and having no shared access. How to do it?
Solution: It is necessary to share the printer anyway, but you should specify the "$" character at
the end of the network name. In this case, the printer will not be seen for other users, but the
program will be able to monitor it. Or you can install the remote client on this computer.

Problem: The program is configured as a service, and there is no program window on the desktop.
When I try to run the program using the desktop shortcut, I get the message that the program's
instance is already running. How do I change the program settings?
Solution: Stop the Accurate Printer Monitor service from the Control Panel. Run the program using
the desktop shortcut. Change the necessary settings. Close the program and start the service again.

Problem: It is impossible to get the contents of print jobs for viewing in PDF format.
Solution: The following two situations are possible:
1. Make sure that the file #####.spl appears during printing. Where ##### is a number (for example,
00002.spl) in the print job content folder you created in the program settings 10 . The default folder is
c:\Users\All Users\Accurate Printer Monitor\spool\. If there are files that look like FP#####, follow the
instruction below to disable "Spool File Pooling" on the print server and try printing again.
The "Spool file pooling" option is disabled by default on a print server running under Windows 2000.
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On a print server running under Windows XP / Windows Vista / Windows 7:
· Click the "Start" button, then click "Run", type regedit in the input field, and click OK.
· Find the following registry key where <printername> is the name of your printer:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Print\Printers\<printername>
· Right-click the SpoolDirectory value in the right panel and select "Edit".
· Copy the DefaultSpoolDirectory value from
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Print\Printers to
the input field (for example, c:\windows\system32\spool\printers)
· Repeat steps 2 to 4 for other printers.
· Close the registry editor.
· Restart the "Print Spooler" service in the Control Panel (Control Panel --> Administrative Tools -->
Services)
On a print server running under Windows 2003 / Windows 2008:
· Click the "Start" button, then click "Run", type regedit in the input field, and click OK.
· Find the following registry key where <printername> is the name of your printer:
·
·
·
·
·
·

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Print
Select "New" on the "Edit" menu and then select "DWORD parameter".
Type "DisableServerFilePooling" in the first input field and press ENTER.
Right-click the DisableServerFilePooling value in the right panel and select "Edit".
Type 1 in the value input field to disable "spool file pooling" and then click OK.
Close the registry editor.
Restart the "Print Spooler" service in the Control Panel (Control Panel --> Administrative Tools -->
Services)

2. The program does not support the format of the current printer driver.
In this case, the program cannot convert the print job image file into a readable PDF format. To solve
this problem, try one of the following options:
2.1. Disable the "Enable Advanced Printing" option on the "Advanced" tab in the printer properties.
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2.2. If variant 2.1 does not help, enable the "Enable Advanced Printing" option but change the data
type from RAW into NT EMF 1.008 in the "Print Processor" properties.
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2.3. If variant 2.2. does not work, try using another printer driver (for example, the Postscript printer
driver or the PCL printer driver), and then repeat 2.1 and 2.2.
4.6.1.7

Database structure
You can select the option of preparing a database during the installation of the program. A database
with the following structure is created in this case (a MySQL sample database). Anyway, scripts for
creating a database are added to the data folder in the program folder (one file for every database
type).

PM_EVENTS
This table contains all data by received events. Reports will be based on this data.
Column
name

Data
type

Siz Canno Description
e
t be
empty

PE_ID

INTE
GER

10

Unique event identifier

PE_DATE1

DATE
TIME

0

Event date and time

PE_C LASS

VARC
HAR

20

Event class: JOB - print job, PRINTER - printer

PE_PRINTER

VARC
HAR

80

Printer name (network printer name)

PE_PRINTER
_NAME

VARC
HAR

80

Full printer name (network printer name)
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PE_MAC HINE
_NAME

VARC
HAR

50

The name of the computer where the printer is
located

PE_PRINTER
_ID

INTE
GER

11

Printer identifier from the PM_PRINTERS table.
Updated when reports are printed.

PE_USER_NA
ME

VARC
HAR

50

The name of the user who added the print job

PE_STATUS_
FLAGS

INTE
GER

11

Print job flags. The number is a bit-wise mask

PE_STATUS

VARC
HAR

80

The PE_STATUS_FLAGS field translated into a
string

PE_DOC UME
NT

VARC
HAR

12
8

Printed document name

PE_SUBMITT
ED

DATE
TIME

0

Date and time when the document was sent to the
printer

PE_TOTAL_P
AGES

INTE
GER

11

Total number of pages in the document

PE_PAGES_P
RINTED

INTE
GER

11

Printed pages

PE_SERVER_
NAME

VARC
HAR

50

Contains the name of the computer where the
printer is located for events of the "PRINTER" type

PE_SHARE_N
AME

VARC
HAR

50

Contains the network printer name for events of the
"PRINTER" type

PE_C OMMEN
T

VARC
HAR

50

Comments

PE_LOC ATIO
N

VARC
HAR

50

Printer location

PE_SEPFILE

VARC
HAR

50

The name of the file that was used to create a
page separating print jobs

PE_PRINT_P
ROC ESSOR

VARC
HAR

50

Print processor type: EMF, RAW or TEXT

PE_PARAMET
ERS

VARC
HAR

50

Print processor parameters

PE_DATATYP
E

VARC
HAR

50

Data type used to write print jobs

PE_ATTRIBU
TES

VARC
HAR

12
5

Printer properties

PE_PRIORIT
Y

VARC
HAR

15

Print job priority in the queue

PE_DEFAULT
_PRIORITY

VARC
HAR

15

Default priority

PE_START_T
IME

DATE
TIME

0

Date and time the print job must not be printed
earlier
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PE_UNTIL_TI
ME

DATE
TIME

0

Date and time the print job must not be printed
later

PE_STATUS_
STRING

VARC
HAR

50

Print job status

PE_C JOBS

INTE
GER

11

Number of print jobs at the printer at the moment
when the event occurred

PE_AVERAGE
_PPM

INTE
GER

11

Average number of pages per minute

PE_NOTIFY_
NAME

VARC
HAR

50

The name of the user who must be notified when a
job is finished or an error occurs

PE_DRIVER_
NAME

VARC
HAR

50

Printer driver name

PE_POSITIO
N

INTE
GER

11

Print job position in the queue

PE_TIME

INTE
GER

11

Seconds after the moment the printing was
started

PE_TOTAL_B
YTES

INTE
GER

11

Bytes sent

PE_BYTES_P
RINTED

INTE
GER

11

Bytes printed

PE_PAPERSI
ZE_TYPE

INTE
GER

11

Paper type amount

PE_PAPERSI
ZE

VARC
HAR

50

Paper type

PE_PAPERLE
NGTH

INTE
GER

11

Paper length

PE_PAPERWI
DTH

INTE
GER

11

Paper width

PE_C OPIES

INTE
GER

11

Copies

PE_PRINTQU
ALITY

VARC
HAR

12

Print quality (DPI)

PE_C OLOR

INTE
GER

11

Color printing flag

PE_ORIENTA
TION

VARC
HAR

12

Page orientation

PE_DUPLEX

INTE
GER

11

Duplex printing flag

PE_MEDIATY
PE

VARC
HAR

32

Paper type

PE_SHEETS_
PRINTED

INTE
GER

11

Sheets printed
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PM_PRICES
The table contains the description of print cost for printers
Column
name

Data
type

Siz Canno Description
e
t be
empty

PPR_ID

INTEG
ER

10

Unique price identifier

PPR_PRINTE
R_ID

INTEG
ER

11

Unique printer identifier

PPR_DATE1

DATE
TIME

0

Price activation date

PPR_DATE2

DATE
TIME

0

Price expiration date

PPR_PAPER
SIZE

INTEG
ER

11

Paper size

PPR_PRINT
QUALITY

VARC
HAR

20

Print quality

PPR_C OST_
BW

FLOAT

0

Black-and-white printing price

PPR_C OST_
C OLOR

FLOAT

0

Color printing price

PPR_C URR

VARC
HAR

20

Currency

PM_PRINTERS
The table contains printer descriptions
Name

Data
type

Siz Canno Description
e
t be
empty

PP_ID

INTEG
ER

10

Unique printer identifier

PP_HOST

VARC
HAR

80

Computer name

PP_NAME

VARC
HAR

80

Printer name

PP_DESC

VARC
HAR

12
8

Printer description
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PP_DATE

DATE
TIME

0

Printer addition date

PP_AC TIVE

BIT

1

Active printer flag

PP_UPDATE
D

BIT

1

Updated printer and PM_EVENTS page update is
required flag

PM_USERS
The table contains the description of built-in web server users
Name

PU_ID

Data
type

Size Canno Description
t be
empty
Unique user identifier
INTEG 10
ER

PU_LOGIN

VARC H 50
AR

Username

PU_PASS

VARC H 50
AR

Password

PU_DATE

DATET
IME

0

Updated user date

PU_ALLOW
_LOGIN

BIT

1

Allow authentication

PU_ALLOW
_FAV

BIT

1

Allow favorite reports

PU_ALLOW
_C UST

BIT

1

Allow random reports

PU_ALL_DA
TA

BIT

1

Access to data for all users
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4.6.2

Additional parameters

4.6.2.1

Data view change

Fig. 3.1.1. Data view

Data view settings, that can be configured on the "Data view" tab:
1.

2.

3.
4.
5.

View characters with code - the program can interpret and decode bytes as characters. You
can select decoding mode for each range of character codes. If the range doesn't have the
corresponding character, that's why these data can be displayed only in hexadecimal and
decimal code.
You can set up the user's format to display a data byte. The directive %d shows to display a
decimal code, the directive %x - hex code. You can set any framing characters before/after the
user format.
Highlight data sent on screen - a string with sent data will be highlighted by the selected
color.
Character set - allows you to define the character set of incoming data. Windows - Windows
ANSI character set, DOS - OEM character set.
Data source custom color - if you've created several configurations then you can define a
custom color for each data source that allows you to distinguish data flows on the "All data"
page in the main window.

© 1999-2021 AGG Software

Program use
6.

7.

8.

4.6.2.2

33

Split strings by data timeout - this option allows visually splitting data packets in the program
window. Data packets that will be received after the specified interval will be shown on a new
line. If this value is set to 0, then data packets will not be split.
Split continuous data blocks large than - this option allows visually splitting continuous data
flow in the program window. The program will show data on a new line if continuous data is
longer than the specified number of bytes.
Split by characters - this option allows to visually splitting continuous data flow in the program
window using the specified symbols. For example (fig. 3.1.1), the program will use a character
with the 0Ah hexadecimal code that is equal to the "LF" ASCII code.

Date/time configuration
This group of options (fig. 3.2.1) allows you to configure how timestamps appear in the log file and on
the screen. You can configure the stamp format in the program options 80 .

Fig. 3.2.1 Tim e stam p configuration

Add to display output for data sent - the time stamp will be added for the sent data displayed on
the screen. The stamp will be added according to the timeout (if the data flow is uninterrupted) or
when a data packet is sent.
Add to display output for data received - the same but for the received data.
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Add if data direction has been changed - if the program is sending and receiving data, the time
stamp will be also added when the data transfer direction changes (sending/receiving).
Add for data packets - if the data is displayed after it is processed, the stamp will be added to each
processed data packet.
Add at begin of file - the stamp will be added at the beginning of every new log file.
Stamp timeout - if the data flow is uninterrupted, the stamp will be added regularly at the interval
specified in milliseconds.
File prefix/postfix character(s) - the program will use these characters instead of those specified
in the program options 80 while writing data to a file. For example, it allows you to add the new line
character or another sequence of characters before or after the stamp. Example: >#0D#0A
4.6.2.3

Name and security
This group of options (fig. 3.3.1) allows you to configure the following parameters:
Friendly name - this name will be added before the port number or the data source in the drop-down
list in the main window of the program. It allows you to describe the data source.
Start logging automatically - if this option is enabled the program will start receiving and logging
data automatically when it is launched.
The "Security" option group allows you to protect user operations in this particular configuration with
a password. You can specify advanced security options applied to the entire program in the program
options 87 .
Ask password before start and stop - the password will be required when the user clicks the
"Start/Pause" button in the main window of the program.
Ask password before configuration edit - the password will be required when the user tries to
open the Configuration options dialog box.
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4.6.3

Log files

4.6.3.1

Log rotation
The main function of Accurate Printer Monitor is logging data to a file (so-called, log file). The "Log
rotation" tab has a rich set of options for it. (fig. 4.1.1).

Fig. 4.1.1 Log-file form ing m odes

First of all, select log file what you can configure:
· Log file for data received - all data received will be saved using these settings.
· Log file for data sent - these settings will be used to save sent data. If you want to save data

to the same file, as data received, then select the "Log file rotation for data sent" option from the
list and enable two options: "Create log files on disk" and "Write to log for data received." Of
course, you should configure a log rotation for data received before.
Set the "Create log file on disk" option to the checked state. Then you can set path to a folder,
where files will be created with the help of a dialog window, which will be showed up after clicking a
button with the "Folder" picture. You should select a necessary folder in the dialog window and click
the "OK" button.
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Log file path - the full path to a local or network folder, where the program will create new log files.
The network path should be specified as: \\COMPUTER NAME\Folder\
Note: If the program works with network files, it greatly increases data flow through your network and
decreases writing speed. Please, consider creating small log files. If your incoming data flow is fast,
you may create log files locally. Later, you may sync a local folder with a remote folder using any 3rd
party utility.
A log file name can be stamped with date and time. In this case, a new log file is created
periodically. The format of a timestamp depends on the selected period. For instance, if the "File
name prefix" field is set to "sample," the "File extension" field to "log," and the "File name
format" option is "Daily," then each log file created will have the format "sampleYYYYMMDD.log".
On March 21st, 2003, the log file will be "sample20030321.log". Please, note, that the final extension
(after the final period), remains at the end of the file name.
Write to log - the option allows you to select when the program writes data to a log file. This feature
is disabled in some loggers, and if the parser plugin is not available.
· Before parsing - the program saves all incoming data without any modifications. If an external

device sends binary data, the logger will create binary files.
· After parsing - the program saves data after parsing. Generally, it is a parsed data packet.
· After filtering - the program saves data after all filter plugins. The logger saves the content of

the "FULL_DATA_PACKET" variable. A filter plugin may transform or fully change the variable. If
you do not use any filter plugin, then this mode works as the previous.
· Screen content - the program saves data to a log file as you see it in the main window.
Generally, it is text content; therefore, the program creates a text log file.
The log rotation mode is defined by the following key parameters:
· File name prefix - the text string, which will be added at file name beginning. The prefix may

contain special placeholders like {NAME}. If you create log files before parsing the NAME can
be any date formatting values below. For example: "data{YYYY}_{MM}_{DD}" returns a prefix
like "data2019_01_01". If you create log files after parsing or filtering, you may use any parser
variable. Then the file name may depend on some value in your incoming data.
· File name extension - the text string, which will be a file extension (characters after the dot).
Limit size - the "Limit size" field specifies the maximum size in kilobytes of any log file. If you
specify the zero file size, then the file size is not limited.
You may select from the following modes:
1. Clear file - if the log file size will exceed the limit specified, then the log file content will be
deleted, and file filling will start from the beginning.
2. Rename old - if the log file size will exceed the limit specified, then the existing log file will be
renamed.
3. Shift (no threshold) - the older data over the limit specified will be removed from the log file.
4. Shift (with threshold) - in this mode the program will wait when the file size will exceed the limit
specified + the threshold value. After this, the older data over the limit specified will be removed
from the log file.
If the program continuously works for a long time, it is possible that the log file will have a large size
and this file will be inconvenient for looking and analyzing. Therefore, there is the possibility to create
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files in dependence with the time on a computer. You can select one variant predefined or set up a
new one:
· Daily - the file will be created with a name containing a prefix, and date in format DDMMYYYY,

·
·

·

·

·
·
·

·

where DD is two-digit day sign, MM is two-digit month sign, and YYYY is four digits of the
current year. The filename extension will be added at the end of the file.
Monthly - the file will be created with a name containing a prefix, and date in MMYYYY format.
The filename extension will be added at the end of the file.
Each data packet in different file - in this mode, the program splits data flow to a different file.
In this mode you should configure the parser or the program will split a data by timeout about
300 milliseconds.
Don't create new file - in this mode, the program will write all data to one file. It is
recommended for a small data flow. Otherwise, your log file will be too big, and a performance of
the program will fall down.
User's format - a file will be created with a name containing a prefix and date in showed by you
format (for example, DDMMYYYY). The filename extension will be added at the end of the file.
The file may not contain format signs, then file name will be constant. You should not use
characters, that the OS doesn't allow in a file name, such as "/,\.*,?" and some others.
Weekly - create a new file every week. The file name will contain a week number.
After data timeout - the program will create a new file if the program didn't receive any data at
the specified interval.
Hourly - the file will be created with a name containing a prefix, and date in format
YYYYMMDDHH, where HH is two-digit hour sign, DD is two-digit day sign, MM is two-digit
month sign and YYYY is four digits of the current year. The filename extension will be added at
the end of the file.
Constantly named file - the current log file will have a constant name. When creating a new
file, the existing log file will be saved using the new file name that will contain a date and time
stamp.

Date and time formatting codes:
D
- a day number (1-31).
DD
- a day number with a leading zero (01-31).
DDD
- a day of the week in the text form (Mon-Sat), according to the regional settings on this
computer.
DDDD - a day of the week in the full text form (Monday-Saturday), according to the regional
settings on this computer.
M
- a month number (1-12).
MM
- a month with a leading zero (01-12).
MMM - a month name in the text form (Jan-Dec), according to the regional settings on this
computer.
MMMM - the full month name (January- December).
YY
- last two digits of the year (00-99).
YYYY - the full year number (0000-9999).
H
- the hour number (0-23).
HH
- the hour number with a leading zero (00-23).
N
- minutes (0-59)
NN
- minutes with a leading zero (00-59).
S
- seconds (0-59).
SS
- seconds with a leading zero (00-59).
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Example: You want to create a log file every hour. It is desired that file name starts from
"sample_log" and the file extension "txt".
Answer: set file prefix = sample_log_, file extension= txt (without dot!). In file name format show
HHDDMMYYYY. Now the file will be created every hour. Naturally, you can set any formatting
characters combination, described higher.
If you want to access to a log file while the program work, then you should configure access mode
settings 39 for the log file in the next chapter.
Add date/time stamp to file name - this option is available for modes #4 and #7 and allows adding
date and time to the file name.
Add data source ID to file name - if this option is activated, then the program will append the data
source name at the beginning of the file name, for example, COM1-sample20030321.log.
Write data/time stamp to file before writing data - if this option is activated, then the program
will write a date/time stamp to a file before each data portion.
Overwrite existing files - this option is available for modes #4 and #7 and allows you to delete an
existing log file before creating a new log file.
4.6.3.2

Log file access
During work can be such situations, when it is necessary to get access to a file with current data
(current log file) from other applications (for example, for data processing). However, while you are
accessing the current log file Accurate Printer Monitor can't write data to a log file and all data at this
moment will be lost. We recommend using a temporary file for data storage. It is the safest way. (fig.
4.2.1).
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Fig. 4.2.1 File access m ode.

You can select one from the following variants:
· Ignore and not write - in this mode, the program stop writing to a log file until it is locked.

Therefore, data will be lost.
· Write to a temporary file, then append - a temporary file will be created, to which writing will be

done. After access to the current file will be got, temporary file content will be added to the end of
the main file. However, mind that if file has a timestamp in the name, there can be a situation when
the program copies the content of a temporary file to a new log file, for the next time.
· Display a message and stop work - data will be lost until the dialog window is closed.
You can define your message text, which will be displayed at writing error to a log file. The sound
signal can be on for an additional indication. You can also enable writing a message to a protocol
file.
4.6.3.3

Log deletion
The deletion of files (fig. 4.3.1) will help you to avoid stuffing your hard disk with needless information.
Log files can be deleted either depending on the time of storing or when the maximal number of files
is exceeded.
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When deleting files by the time of their storage, the files that were modified last time before the
specified period are deleted.
When controlling the number of files, the files with the oldest modification dates are deleted first.
You can select both variants of file deletion. In that case, files will be deleted when either of the
conditions is true.

Fig. 4.3.1 Log deletion

4.6.4
4.6.4.1

Modules
Introduction & setup
To extend program functionality, we implemented plug-in modules. The module structure lets you to
reduce your program size and purchase costs (you pay only functionality, which you need).
Accurate Printer Monitor supports a few types of modules (fig. 5.1.1 - 5.1.3):
·

Data filter - data filters allow you to filter your data and modify a value of parser variables.
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·

·

Data export (fig.11) - Accurate Printer Monitor has many modules and method for passing
data to other applications, for example, there are modules for various databases, file formats
(CSV, XML), data interfaces (OPC, DDE, MQTT), and many others.
Events handling (fig.12) - these plug-ins are used to handle events generated by the
Accurate Printer Monitor software. Once an event occurs (for example, "Data source is
opened" or "Configuration changed"), the plug-in creates a text message using the specified
template, sends a notification, does some actions, executes a program or a script, etc. The
form of the notification or actions depends on the plug-in settings.

Fig. 5.1.1. Activating plug-ins
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Fig. 5.1.2 Activating data export plug-ins
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Fig. 5.1.3 Activating events handling plug-ins

Installation
You can easily install a new module. Usually, you should start the installation file and click the
"Next" button for a few times. The installation wizard will detect a place of your Accurate Printer
Monitor software and place a plug-in module and all distributive files to the "Plugins" folder, which is
in the program folder (by default X:\\Program Files\Accurate Printer Monitor\Plugins).
After the program restart, a module will be loaded and initialized. If the module is supported by our
software, the module name will appear the modules list (Fig. 5.1.1-5.1.3). Most modules require
additional settings. If you want to configure the plug-in module, click the "Setup" button near it. If you
selected the module and the "Setup" button is not active, then the module doesn't have additional
settings and can work without additional settings. Please, read a user's manual of the corresponding
plug-in for additional information.

Configuration steps
1. Select and configure a query module. You may use a module of this type if you need to send
some data to your device (for example, initialization strings or request strings).
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2. Select and configure a parser module. This step is necessary because filter and export modules
can use parsed data only. If you didn't select the parser module, then you can't configure the data
filter and data export modules.
3. Activate and configure data export modules. You can select one or more modules
simultaneously. The program will use selected modules simultaneously. Please, note, the
program can' use the data export module, if you didn't configure the parser module.
4. Activate and configure event modules. You can select one or more modules simultaneously.
4.6.4.2

OPC server
Since the version 2.1.1 Accurate Printer Monitor has an internal OPC server. It means that any OPC
compatible client application can get data from Accurate Printer Monitor without any additional
software. To connect to the OPC server, you need the server ID and name (Fig. 5.2.1). Before using
the OPC server on your computer, you should download and install the OPC Core Components
Redistributable from www.opcfoundation.org (registration required).

Fig. 5.2.1 OPC server param eters

Accurate Printer Monitor parses all incoming data to one or more variables, and an OPC client gets it
(fig. 5.2.2). After connecting to the OPC server, you will get a list of all variables.
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Fig. 5.2.2 OPC server active item s

Clients activity is showed on the "Active clients" tab. The top node is client, below is a group of
items and connected items. By double-clicking, you can get detailed information about each node.
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Fig. 5.2.3 OPC server clients

Accurate Printer Monitor creates new variables at "on-the-fly" mode. The Accurate Printer Monitor
starts without any variables and gets it only after first data had been received. If your client OPC will
connect to the OPC server before than data had been processed, then it will get an empty list of
variables, and your OPC client should poll the OPC server for updating list of variables. If your OPC
client doesn't allow it, then you can pre-define all variables (fig.5.2.4). In this case, the OPC server
will create these variables with empty values, immediate after starting, and your OPC client will get
these names while connecting.
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Fig. 5.2.4 OPC server pre-declaration

4.7

Administration and reports

4.7.1

First launch
The "Accurate Printer Monitor" program consists of two parts:
· Logger. This part of the program controls all events and adds them to the database. This part of

the program runs completely automatically. It can run as a service and be completely invisible to
the user.
· Administration program. This part of the program is used to generate reports and perform other
service functions.
This part of help describes the administration program.
After you successfully install Accurate Printer Monitor, you should configure the program.
Start the administration program (in the future "the program") from the "Start" menu.
After you start the program, you will see its main window (fig. 1), whose main elements are the main
menu, the toolbar, the data output area, the status bar, and the navigation bar. You will see data
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about events from the database in the data output area. The status bar shows a hint for many
interface elements, information about operations in progress, etc. You can access the program's
preferences from the main menu of the program ("Edit - Preferences...").

Fig. 1 Main w indow

By default, the program is configured to be used on one computer with the logger. PostgreSQL is
used as a default database. If you plan to use the administration program on another computer, you
should install and configure an MSSQL or MySQL database.

It is as easy to get to know the program as 1-2-3-4-5
Step 1. Configure the logger that will collect and log data to the database.
Step 2. Make the list of printers
Step 3. Specify the print costs

54

57

you will monitor.
for the printers if you want to calculate them.

Step 4. Create the list of your favorite reports on the "Reports

62 "

tab.

Step 5. Customize the program options. Particularly, enable the built-in HTTP server
remotely view the reports or make the list of scheduled reports.
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Now you can view, print, and save reports about printers that the logger monitors to files on the
"Reports 62 " tab.

4.7.2

General information
All source data are presented as a table in the program. You can find out how to work with these
tables below.

Fig. 2 Table w ith data

Each table has navigation buttons at the bottom (fig. 3).

Fig. 3 Navigation bar

Navigation buttons
Buttons (left to right):
1.
2.
3.
4.
5.
6.
7.

First - move to the first record in the table.
Page Up - move to the record one page up.
Previous - move to the previous record.
Next - move to the next record.
Page Down - move to the record one page down.
Last - move to the last record in the table.
Insert - insert a new record into the table next to the current one.

© 1999-2021 AGG Software

Program use

51

8. Add - add a new record to the end of the table. After you save the record, it will be sorted
according to the sorting rules.
9. Delete - delete the selected records. You can also delete records by pressing the “Delete” key
on the keyboard.
10. Edit - edit the current record. You can edit a record by clicking the current cell in the table.
11. Save - save the changes in the current row.
12. Cancel - cancel changes in the current row in the table.
13. Refresh - refresh the current row.
14. Filter - open the dialog box where you can configure filtering the data (fig. 4)
Some navigation buttons can be unavailable. It depends on the data shown in the table.

New filter

Fig. 4 Filter

This dialog box allows you to configure the filter you can use to filter data in the table by the
condition you specify. You can select the condition each column will be checked by. You can
specify complex rules by adding several conditions.
You can save the filter to a file and load it later using the corresponding button.
Click "OK" after you finish editing the filter.

Quick filter
You can access the quick filter if you move the mouse pointer to the column header's right edge (fig.
5). If you click the button, you can open a drop-down list to select the value for the filter. This filter is
limited in the "Events" table not to slow down the program.

© 1999-2021 AGG Software

52

Accurate Printer Monitor

Fig. 5 Quick filter

Column customization
The program allows flexible customizing columns. You can:
Change the order of columns. Just click the column header and move the column to the
necessary position holding down the mouse button.
Quickly sort data in the table. Click the column header. If you need to sort data by two or more
columns, hold down the “Shift” key when you click the column header.
Hide columns in the table. Open the "Columns editor" dialog box (fig. 7) using either the toolbar
(fig. 6) or the popup menu.

Fig. 6 Toolbar
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Fig. 7 "Colum n editor" dialog box

You can customize the order and the set of columns in the table in this dialog box. The program
allows you to create several Column views, which will allow you to filter data by the necessary
condition and quickly switch between column views.
Select the checkbox of the column name for the column to be shown in the table. You can change a
column's position by dragging it to the necessary position (hold down the mouse button on the
column number). After you change the settings, you should save them with a click on the toolbar.
You can create new data types and delete existing ones with clicks on the "+" and "-" buttons.
When you exit the program, the current view will be saved and restored when you start the program
next time.
After you exit this dialog box, all new column views will be displayed in the toolbar's drop-down list.
You can use the following items on the popup menu of the table to customize the column size.
Adjust columns. The program will calculate the column width depending on the value in it. The
column width will correspond to the width of the cell with the longest value.
Proportional column width. The column width will be automatically calculated depending on the
table width.
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4.7.3

Creating the printer list
The printer list is necessary for the program to follow expenses on printing and to calculate its cost.
To create the list of printers for monitoring, select the "Printers" page on the navigation bar (fig. 8)

Fig. 8 Printer list

You should create your printer list in the upper table and specify the printing cost for each of them in
the lower table. The program can offer you several ways to speed up the process of creating the list.

Printer list
If the logger configured earlier has already been collecting data for some time, you can create the
printer list by importing this information from the event table. To do it, click the
button on the
toolbar. Select the printers you want to add in the new dialog box (fig. 9). The printers already added
earlier will be disabled in the list.
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Fig. 9 Printer im port

If you are going to take the cost of printing into account, it is recommended to specify the default
cost for the selected printers. To do it, click the link in the hint and specify the cost of printing color
and black-and-white pages in the new dialog box (fig. 10). It will rid you of the routine of compiling a
large list of printers. The default cost will be used for any page size and print type until you specify
additional conditions. You will be able to add and change the cost of printing for each printer later.
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Fig. 10 Default print cost

After you select printers in the list, you should click the "Add" button. The selected printers will be
added to the table, and the default cost will be added for each printer.

Printer list optimization
If you have several printers of one type installed on several print servers and the print cost is the
same on all of them, you can considerably reduce the printer list using the special mask character
"*".
Example: The "Adobe PDF" virtual printer is installed on all office computers. Printing on it does not
cost anything. To avoid specifying this printer for each computer, just set the value in the "Host or IP"
field to * and set the printing cost for this printer to 0 (fig. 8). Now the program will automatically use
this value for the Adobe PDF printer on every computer.
Example 2: The printers "Epson Stylus Photo RX600" and "Epson Stylus Photo RX500" are
installed on the print server PRN1 and PRN2. They can print only A4 pages. The cost of printing is
the same on both computers. So it is enough to add an entry to the printer list where:
1. The hostname or IP is set to PRN*
2. The printer name is set to Epson Stylus Photo RX*
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Specifying the print cost
If the printer is used to print only black-and-white documents on paper of one format, you can use the
default cost. Suppose the printer can print various documents like most Inkjet printers. In that case,
it is recom-mended to specify the price for various types of documents to calculate the cost of
printing more precisely.
To specify the cost of printing, select the necessary printer in the "Printer" column, and specify one
or more costs for different print options (fig. 11)

Fig. 11 Print cost

1. The start date when the cost becomes active is specified in the "Start date" field.
2. The end date when the cost becomes inactive is specified in the "End date" field. If the terms are
not defined for this cost, you can leave this field empty.
3. Select the paper type from the list in the "Paper size" field.
4. Select the print quality in the "Print quality" field. Quality > 2000 dpi corresponds to photoquality printing.
5. Specify the cost of one black-and-white page in the "Price for BW" field.
6. Specify the cost of one color page in the "Price for color" field.
7. Specify the currency in the "Currency" field.
The program searches through all operational costs. It selects the most appropriate print cost for
each separate print job.
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If you need to specify a print cost for several printers in the list, the program offers you a comfortable
way to do it. Select the necessary printers in the table and click the
toolbar button. You will see
the "Add cost" dialog box (fig. 12).

Fig. 12 Adding the cost

You should specify the same print parameters as in the table above. After you click the "Add"
button, the program will add the specified print cost for all selected printers.
If there is already the print cost with the same parameters (page size and print quality), the program
will automatically set the end date for the old cost.
If you enable the "Update existing cost" option, the program will replace the old print cost with the
same parameters. It may be helpful if you do not want to keep the history of print cost changes.

4.7.4

Quotas
Quotas allow you to limit print jobs for a user, printer, or department (fig. 13). You may define a limit
of pages or protect everything by a password.
The program checks quotas in the following way:
1. When a user tries to send a print job to a printer, our remote agent program intercepts that
requests.
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2. The remote agent program prompts for a login and password. The log field is optional and
depends on the server settings.
3. The remote agent program sends a request to a central server to check a quota.
4. The agent blocks or allows a print job using the default settings if the server is offline or
unreachable for 5 seconds.
5. Otherwise, the agent blocks or allows a print job using a returned answer.
6. Also, the server records login and password used for the corresponding print job for reports.

Fig. 13 Quotas

Printer. It is a list of configured printers. You may select one printer from the list, and the program
copies the printer name and location to separate fields. Later, the program does not use this column.
Division. This column allows selecting a division for a quota. The quota will be applied to all printers
assigned to that division. It would be best to choose the "Department page count" rule in the "Limit
type" column.
Date. It is an informational field when you've added a new quota. The program does not use it while
checking quotas.
Printer name, Printer location. These fields identify a printer for the "Printer page count" rule. If
you should define a rule for several similar printers, you can use the special mask character "*". For
example, it allows defining a rule for all printers on one computer or for all printers on all computers.
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User name. This column contains a user name (login) that the program checks for a quota. If this
field is empty or contains "*", the quota is defined for all users. The program checks quota rules with
a user name in the first place.
Limit. This column contains a page limit for the corresponding rule type. The program counts pages
for the current month only.
Password. It is a PIN code or a password that a user should input to continue printing. It only works
for the "Password or PIN code" limit type.

4.7.5

Event log
The event log table contains all data the logger has saved to the database. Reports are based on this
data. You can view and delete data, but you can neither edit nor add it.

Fig. 14 Event log

The table contains more than 40 columns with parameters characterizing this or that event. You will
find it comfortable if you create several column sets 52 .
The "Event class" column shows the event type.
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JOB - if the row in the table is of this type, it describes print job's status. The table may contain
several rows for one job that are generated when one or several job parameters change (for example,
its status).
PRINTER - if the row in the table is of this type, it describes the printer's status. A new row is
generated in the log when one or several parameters change, for example, the printer status.
The purpose of the rest of the rows is clear from their headers.

Deleting old events
The program can delete old events both automatically and at the user's request.
You can specify the deletion options in the program preferences (fig. 15). Select the "Edit Preferences..." in the main menu and switch to the "Database" page to open this dialog box.

Fig. 15 Database settings

You should specify the number of days to keep the event log for in the "Store events" field.
To delete data on the user's request, select the "Tools - Delete old events" menu item in the
program's main window.
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For the program to delete old events automatically, enable the "Automatically delete old events"
option. Old events will be deleted at the program startup in this case.

4.7.6

Reports
The program does not contain preset reports and allows you to create them at your request. You can
configure the report parameters and add a customized report to your favorites, thus making your list
of reports with individual parameters.

Fig.16 Report page

Date range. These options allow you to select a preset date range for the report. If you need to build
a report for a certain interval, you should specify it in the "From" and "To" fields.
Report type
1. Detailed. It is a detailed report by events. It contains the main information about events. If you
select this report type, the other options are disabled.
2. Detailed (columns from Events page). It is the same as the previous report, but the report
contains the data that is currently displayed in the table on the "Events" page. This way, you can
include only the data that you want to view in the report.
3. Bytes printed - the report with data about the number of bytes sent to the printer.
4. Pages printed - the report about the printed pages.
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5. Bytes and pages printed. This report contains the number of both printed bytes and printed
pages.
6. Pages printed + cost. The report is the same as #4, but the print cost is calculated. The print
cost calculation considerably influences how fast the report is built.
7. Bytes and pages printed + cost. It is the same as #5, but the print cost is calculated.
8. Printer failures. The report contains errors retrieved from printer drivers or via SNMP. The report
may include messages about low toner level, paper out, opened printer cover, etc.
9. Cartridge: Toner level. The report works only for network printers with the SNMP monitoring
option enabled. The program retrieves and logs information about a toner level. If a printer has
color cartridges, the program stores info about these cartridges too. The report shows the last
received toner level for the select time interval. Please, note, only a limited number of printers
support SNMP monitoring. Sometimes, you should enable it in the printer settings.
10. Cartridge: Serial number. The program can retrieve a cartridge's serial number with a toner
level. The report allows you to get a history of cartridges replacement. Please note that the
cartridge data's storage depth depends on the storage depth 74 of the event data.
11. Quotas: List. This report allows you to get info about all active quota rules.
12. Quotas: Used PIN codes or passwords. This report shows usage statistics of PIN codes or
passwords defined in quota rules.
Group by - here, you can select one or several fields for grouping the data.
Show as - allows you to select the report view.
·
·
·
·
·
·
·

Table - table view.
Graph - graph view.
Histogram - histogram view.
Pie - pie chart view.
Linear - linear graph view.
Dot - dot graph view.
Region - a graph by regions.

Sort by. This option allows you to sort data by the necessary column. Columns the data is grouped
by come first in the list.
Options
·
·
·
·
·
·
·
·

3D view - 3D graphs.
Colored - color graphs.
Show legend - show the legend on graphs.
Show axis - show the axes on graphs.
Single - show one graph for all values.
Top 10 only - show only the first 10 values.
Ascendant sorting - sort in the descending or ascending order.
Marks - enable marks for each value on the graph that can contain a value or mark.

A change in most report parameters will trigger a 10-second timer, and the report will be
automatically updated after that. You can also update the report with a click on the
toolbar
button.
You can print the generated report with a click on the
"Export" menu.
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You can get any report by combining the above parameters.

Report preferences
If the generated report does not fit on one page, you can:
1. Change the size and format of the page with a click on the
toolbar button.
2. Change the font that is used in the report and its size. To do it, select "Options - Additional..."
and specify the necessary parameters in the new dialog box (fig. 17).

Fig. 17 Report page

Font type, Font size, Font color. These options allow you to select a font type to be used in the
report.
Highlight odd rows. It allows you to enable highlighting odd rows in the report. If it is enabled, odd
rows will be shown with the background color specified below.
Print highlighting. If this option is enabled, the printed report will be highlighted. Otherwise, only
the preview will be highlighted.
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Wrap words for text fields. If the value of a column in the report larger than its width, and this
option is enabled, the height of the row will increase and part of its value will be moved to the next
line. Otherwise, the value will be trimmed according to the column width.
Print date in footer. If this option is enabled, the program will print the page number and the current
data in each page's footer.

Creating the list of favorite reports
To add a report to your favorites:
1.
2.
3.
4.
5.

Configure the report as described above.
Generate the report.
If you are satisfied with the generated report, click the
button next to the list of favorite reports.
The program will offer you to specify the report name. You can specify any name.
Click OK after you type the report name, and the report will be added to the list of favorite reports.

To remove a report from the list, you should click the button:

4.7.7

Dashboard
The "Dashboard" tab (fig. 18) allows you to get instant information about current print jobs and
average statistics.
The program calculates statistics for an interval defined in the "Interval" field.
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Fig. 18 Dashboard

The "Last print jobs" tab (fig. 19) shows the last available information for each printer for the selected
interval.
The program shows toner level only for network printers that support SNMP monitoring.
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Fig. 19 Last print jobs

4.7.8

Scheduled reports
This feature allows you to receive reports the program will automatically generate according to the
schedule by email at the specified time. To activate and configure this feature, select "Edit Preferences..." and switch to the "Scheduled reports" page (fig. 20).
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Fig. 21 Scheduled reports configuration

Activate scheduled reports. This option activates scheduled reports.
The "Send reports" group allows you to specify when the reports will be generated, at what time and
in what format they will be sent, data for which interval they will include.
Recipients. The field contains the list of addresses the message with attached report files will be
sent to. You can specify several addresses separating them with a semicolon.
The "Included reports" list contains the list of reports that should be generated and sent. This list is
based on the list of your favorite reports. So you need to create the list of your favorite reports 65 first
and then import it to the list of scheduled reports by clicking the "Import" button. Here you can leave
only the ones you need in the list of scheduled reports. You can use the popup menu to delete a
report from the list.

Email settings
For the report to be sent, you should specify the email settings. To do it, open the "Email settings"
page (fig. 22).
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Fig. 22 Em ail settings

Messages are sent via the SMTP protocol that is standard for sending emails. That is why you
should open access for sending email for the program in your firewall. The program sends all
messages using the sender data you can specify in the "From address" and "From name" fields.
Specify the mail server address in the "SMTP host" field. If the server uses a nonstandard port,
specify it after a colon: www.aggsoft.com:2525
User name. This field contains the SMTP server username. Usually, it is the email address of the
following type: yourname@yourserver.com.
Password. It is an SMTP server password that usually coincides with the mailbox password.

4.7.9

HTTP server
Our program has a built-in HTTP (web) server. The HTTP server will enable you to view reports
remotely using a regular browser. The program allows you to provide employees with access to
personal reports.
To activate and configure this feature, select "Edit - Preferences..." and switch to the "Web server"
page (fig. 23).
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Fig. 23 HTTP server settings

Listen port. The HTTP server will use this port to send data to the clients. The default value of this
parameter is 8081. If another server already uses this port, you can specify any suitable value.
To access the server from the same computer where the program is running, you should type the
following in the browser address line: http://127.0.0.1. If you specify a nonstandard port, specify it
after a colon. For example, in the case of the above image:
http://127.0.0.1:8081
To access the webserver:
1. Open the port specified in the settings in your firewall.
2. Instead of 127.0.0.1, specify the computer's IP address in the network or its name if you access
the server from the local area network.
Default page. This page will be opened by default when you access the address
http://127.0.0.1:8081.
Web root. This folder will contain pages with reports the remote user will view. It must be possible to
write to this folder.
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You can use this folder to store your page that the web server can send to the remote client.
Templates. This folder contains page templates that the program will use to display pages in the
browser. For an additional fee, the AGG Software company can develop a template in your corporate
style, or you can do it yourself using existing templates. It would be best if you kept the file names of
templates completely changing their contents.
Authentication. This option enables password-protected access. If this option is disabled, everyone
can get access. Otherwise, access parameters are specified in the table below.
You can specify several users with different rights in this table (fig. 23).
There are two users shown in fig. 23.
1. admin - It is the administrator with all rights and password-protected access to all reports and
data.
2. The "*" character is specified as the second user, which means a user with any name. The user
will have to enter the password once he accesses the webserver. In this case, the password is
empty, so the user has to specify only his name. As a result, this user will be able to view only
reports with events related to him.
Suppose you are going to provide access to the webserver via the Internet. In that case, it is
recommended to specify the list of addresses accesses to the webserver is permitted from in the
"Allowed IP addresses" field. If this field is empty, access from any remote computer will be
allowed.
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4.7.10 Window view

Fig. 24 Window view settings

You can specify the following settings on the "Window view" tab (fig. 24):
Minimize at startup. Once launched, Accurate Printer Monitor's main window is automatically
minimized into the taskbar or the icon located next to the clock, depending on other options.
Minimize to the tray (next to the clock). If this option is enabled, the main window of Accurate
Printer Monitor will be automatically minimized, and the icon will be automatically located next to the
clock on the taskbar.
Stay on top. The program will always stay on top of other windows on the desktop.
Grids. This group of options allows you to customize the view of tables with data (type, background,
font color).
Transparency. You can customize the transparency of the main window. The leftmost position is
the normal window view, and the rightmost position is the maximal transparency.
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4.7.11 Log and errors
While the program is running, errors and events that should be logged may occur. These may
include database errors, web server messages, and other events. You can select the types of
message to include in the log on the "Protocol" tab (fig. 25). The log file is located in the Application
Data folder. The log file name is "printermonclient.log."

Fig. 25 Protocol settings

Accurate Printer Monitor works with three types of messages:
Information. Messages of this type inform you about the operations executed at the moment.
Warning. Messages of this type warn you about possible failures or errors. No operations are
required, but it is necessary to run a check.
Error. The program has detected an error that the user will have to fix.
To prevent the log file from growing too large, you can enable the "Clean protocol on start" option.
You can open the current log file using the "File - Open current log file" menu item in the main
window.
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4.7.12 Database settings
The program can work with practically any database that has an ODBC driver. By default, the
program is configured for the PostgreSQL database that comes with the program. You can change
the connection type during the program's installation or using the dialog box in the program's
preferences (fig. 26). Select "Edit - Preferences..." and switch to the "Database" tab to configure the
connection.
Note: These settings change the connection type only for the administration part. Data export to the
logger is configured separately.

Fig. 26 Database connection settings

Connection parameters are specified in the "Identification" group.
Depending on the database type selected in the "Database type" list, the following is specified in
the "Database name" field:
If you configure a connection to the remote server, specify the server name and the database name
separated with a colon. For example, remsrv:dbname points to the DBNAME database located on
the REMSRV server.
You should specify "localhost" instead of "remsrv" for a local database.
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Then specify the username and password for access to the database in the "Login" and
"Password" fields, respectively.
Specify the connection parameters specific for each server in the "Additional connection
parameters" input field.
After you configure the database connection, you can test it immediately by clicking the "Test
connection" button. The program will try to connect to the database. It may take quite a while (up to
three minutes), depending on the database type. The test result will be shown as a message. In
case of an error, the message will contain the server response that will help you determine what
caused it.

Additional connection parameters
Value

Description

Note

AUTOCOMMIT

Use autocommit

APPLICATION
NAME

The name of the application that will be
sent to the server

Only for MSSQL

HOST NAME

The name of the workstation that will be
sent to the server

Only for MSSQL

ENABLE MONEY

Change the NUMERIC data type into the
CURRENCY data type with the precision
(1-4) before sending data to the server

Only for MySQL

FIELD REQUIRED

Display an error message if any field has
the NULL value when a query is executed

LOGIN TIMEOUT

The number of seconds to wait for user
authorization

MSSQL, MySQL

MAX CURSORS

The maximum number of simultaneously
opened cursors

Only for MSSQL

QUOTED
IDENTIFIER

Use identifiers in quotes

Only for MSSQL

SERVER PORT

Specifies the server port for connecting
via TCP/IP

Only for MySQL, PostgreSQL

SINGLE
CONNECTION

Specified whether to use a single
process/connection. By default, it is
FALSE

Only for MSSQL

4.7.13 Service mode
Service mode is helpful if you use scheduled reports 67 or the HTTP server 69 . Both these functions
work only when the program is running. You start the program in the desktop mode and minimize 72
to the system area, but you cannot log out from your account, and it is unacceptable in some
companies with strict security rules.
In service mode, the program runs in the background and executes all scheduled and necessary
tasks. Also, the service automatically starts with Windows and does not require user attention.
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Simultaneously, a user can launch the program in desktop mode and build reports or change the
settings.
You need administrator privileges to manage the service.
Install. This button installs the service in your system (fig. 27). The service will appear in the
"Services" control panel.
Uninstall. This button completely uninstalls the service from your operating system.
Start. This button starts the service.
Stop. It allows you to stop the service. The service will automatically start with Windows on the next
reboot.
Restart. This button restarts the service, for example, to apply changes settings.

Fig. 27 Configuring the service
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4.7.14 Data collection service
The data collection service is an independent program working in the background. This service can
control locally installed printers and receive data from remote agent programs on other computers.
This service saves all data to a database. Accurate Printer Monitor works with saved data.
You can change the data collection service's main settings using the "Edit - Data logging settings"
menu item.
All settings are described in detail in other chapters.

Data logger console
The data logger console allows you to monitor collected data in real-time and fine-tune the data
collection service settings. You can open the console using the "Edit - Data logger console" menu
item.

4.8

Program options

4.8.1

Window view
This tab in program options (fig. 6.1.1) allows you to customize the appearance of the main window
of the program (fig.1.1.1 5 ). You can access this tab through the "Options -> Program options"
menu item in the main window.
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Fig. 6.1.1 Window view setting

You can set the following parameters:
· Start in minimized state - at start Accurate Printer Monitor will automatically minimize the

program window to the taskbar or to the Systray (fig. 6.1.2).
· Minimize to Systray - while the main window of Accurate Printer Monitor minimizes, the

program will automatically put its icon to the system panel near the clock.
· Show data window - if you specify this option, then the program will display all data in the

·

·
·
·

main window. You may disable this option if you log data from many ports on a slow computer.
It reduces the computer's CPU usage.
Output data on screen in minimized state - if you'll enable this option, then the program will
display processed data in minimized state. If you are logging many data sources on a slow
computer, then you can decrease computer central processor load rate with disabling of this
option.
Font type - the data will be displayed with this font type in the main window. We recommend
using mono-spaced fonts in this field, such as Terminal, Courier, or System.
Screen buffer - when the number of lines in the main window exceeds the specified value, the
program deletes old lines from the screen buffer.
Window view - this option group lets you configure data window view mode (a font color, a font
type, a background color).
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· Transparency - in Windows 2000 and later lets you set the transparency of the main window.

The most left position is the normal window view, and the most right position is maximum
transparency.
· Wrap words - if you didn't configure a parser module or your data flow doesn't contain a blocks
separator, then your data without this option enabled will be displayed as one long string in the
data window.

Fig. 6.1.2 Systray - panel near clock
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4.8.2

Date/time stamp view
This group of options (fig. 6.2.1) allows configuring the format of date/time stamps that will be used in
the main program window and log files.

Fig. 6.2.1 Configuring data/stam p view

Prefix/Postfix characters for display output - these options allow you to define the beginning and
ending characters of a date/time stamp that will be shown in the program window. When outputting
data to a log file, the program uses individual characters 33 for each configuration.
View mode - allows you to select the standard or define the custom format of the date/time stamp.
Font - this group allows you to define the color and font of date/time stamp.
Add data direction sign to a stamp - if this option is activated, then the program will append TX or
RX to the end of the stamp.
Add data source ID to a stamp - if this option is activated then the program will data append data
source ID at the beginning of the stamp, for example, COM1.
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4.8.3

Protocol and errors handling
While the program is running, it may generate many messages about errors or events. All these
messages are being registered in a protocol file. The protocol file may contain messages from the
main program and all working plugins. On this tab, you can define the kind of messages, which you
want to put a protocol file (fig. 6.3.1). Here you can set the maximum protocol file size and the
formatting mode.
Usually, the protocol file is in the "AppData" folder and has the name of the program with the 'log'
extension.
On Windows 7 and higher: c:\ProgramData\Accurate Printer Monitor\
On old OS: c:\Document and Settings\All Users\Accurate Printer Monitor\
You can also open the protocol file from the “File” menu in the main window.

Fig. 6.3.1 Protocol settings

Accurate Printer Monitor works with three types of messages:
· Information messages - this type of messages informs you about current operations.
· Warnings - warns you about possible failures or errors. Immediately user reaction is not

required.
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· Errors - the program has detected an error which requires user attention.

There is the possibility to log the following events:
·
·
·
·
·

Program messages - messages about start or stop of the program, etc.
Data query - messages which are generated in a data query module.
Data parser - messages from a data parser module.
Data export - messages issued by a data export module.
Other - other message types.

You can write each type of messages to a protocol file or/and to the list in the main window. Please,
specify necessary options for each message type at "Window" and "File" fields.
If you don't want to allow growing a protocol file size to an unlimited size, then you can enable the
"Clean protocol at program start" or limit protocol file size in the "Size" field.
Some exceptional (unhandled) messages may occur while the program is running. In most cases,
these messages affect the program, and the safest way is to restart the program. Please, specify
the "Restart program at exception" option and the program will be restarted automatically.
If you want to look all program messages, then you can disable the "Don't display messages at
unhandled exceptions" checkbox, and the program will open the exception message window with
detailed information.

4.8.4
4.8.4.1

Service mode on Windows 2000+
Configuration
Windows 2000+ services let you:
· Control service on local and remote computers, including remote computers with Windows

2000+ system.
· Setup actions on emergency service restore in case of failure, for example, auto service or

computer restart (only on computers with Windows 2000 or later).
· Create for services other names and descriptions, to find them easier (only on computers with

system Windows 2000 or later).
· Run service before user login (password input).
· Service can be configured on automatic start after operation system load.

Note 1: you must be logged in as an administrator to change the configuration or control the service
in any way (start, stop, pause, continue).
Note 2: On Windows Vista and later you should start the program with elevated administrator
privileges.
If you want to use the program as a service application, then, please, go to the "Options -> Program
options -> Windows service" tab (fig. 6.4.1), then enable the "Use program as a service" checkbox.
Later, please, specify the start-up type of the service. There are the following variants:
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Fig. 6.4.1 Service settings

1.
2.
3.

Automatic - the service starts automatically with Windows, before user login.
Manual - you can start the service application from the "Services" control panel (fig. 6.4.1).
Disabled - the service is disabled, and does not start at all.

If you want to change the program settings while the program works in the service mode, you can
start a second instance of the program on your desktop, make the necessary changes, and restart
the service with the new settings.
Old Windows versions (before Windows Vista) allows you to use the service in the interactive mode.
In this case, the program places an icon in the system area (fig. 6.4.2).

Fig. 6.4.2 Service icon in Systray
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If the service should write data a database or use another service on your computer, they should be
started before Accurate Printer Monitor. You can configure a list of these services on the "Program
depends on services" tab (fig. 6.4.3).

Fig. 6.4.3 Service settings #2

Sometimes, you may need to start Accurate Printer Monitor before starting other services. In this
case, you should:
·
·
·
·
·

Switch the start mode of a target service to "Manual."
Start Accurate Printer Monitor.
Select the necessary service on the "Depending services" tab.
Select the mode when the logger will start the selected service.
Restart Accurate Printer Monitor.

After you configured Accurate Printer Monitor to work in the service mode, you need to restart a
computer or start the service manually from the "Services" control panel (fig. 6.4.4).
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Fig. 6.4.4 Manual service run (in Window s 2000)

When the service is running, two processes should appear in the Task Manager: printermonsrv.exe
and printermon.exe (fig. 6.4.5). The 'printermonsrv.exe' application implements an interface between
the service manager and the Accurate Printer Monitor software. Unlike srvany.exe utility, our service
stops safely.
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Fig. 6.4.5 Process list

If you want to configure the program as a service, then you must be logged with administrator rights.
The service application can be controlled, stopped, or removed with the help of a command-line. Run
printermonsrv.exe with the following parameters:
·
·
·
·
·

4.8.4.2

/? - a short help.
/I - install service for starting in then manual mode.
/A - install service for starting in the automatic mode.
/D - install service in the disabled state.
/R - remove service from the computer.

Windows Vista+ notes
One of the ways Vista's security was improved was by separating system services and user
applications into separate 'sessions'. Keeping the system services isolated helps to secure them
better, but also makes any interactive interface unavailable to the user. That's where the Interactive
Services Detection service comes in. When a service needs to interact with the user, Interactive
Services Detection presents a dialog that will switch the user to the session where the service is
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running so they can interact with the service. For an excellent, detailed description of this, see next
paragraph.
Many sites recommend disabling this service, but doing so will result in you not being able to
interact with any services that require your attention. This service is run manually by default, so there
is little point to disabling it unless you don't want to be bothered by important information from the
software you may be trying to run.
·
·
·
·

Display Name: Interactive Services Detection
Service Name: UI0Detect
Process Name: UI0Detect.exe
Description: Enables user notification of user input for interactive services, which enables access
to dialogs created by interactive services when they appear. If this service is stopped, notifications
of new interactive service dialogs will no longer function, and there may no longer be access to
interactive service dialogs. If this service is disabled, both notifications of and access to new
interactive service dialogs will no longer function.
· Path to Executable: %windir%\system32\UI0Detect.exe
· Default Start-up:
* Home Basic: Manual
* Home Premium: Manual
* Business: Manual
* Enterprise: Manual
* Ultimate: Manual

4.8.5

Restart & Security
Sometimes the program should be restarted. For example, if you've changed the program settings
remotely and want to reload program automatically with the new settings. To do that, specify the
time for restarting the program on the "Restart & Security" tab in program options "Options>Program options". Just specify the time of day, when the program should be being restarted.

© 1999-2021 AGG Software

88

Accurate Printer Monitor

Fig. 6.5.1 Program restart settings

On this tab, you can also protect some actions with the program by a password. To do that, activate
the "Protect by password" option, define a password and select protectable actions.

5

Having problems?

5.1

Program doesn't run or work
It is necessary to make sure in proper time installation on your computer, so as if you put clock after
program installation, protection from use after trial period works.
Also, the program will not work, if you use a software debugger in your environment like WinDbg. In
any other case, please, contact us on support@aggsoft.com.
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